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in the hope that it will be useful,but WITHOUT ANY WARRANTY; without even the implied
warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU
Lesser General Public License for more details. You should have received a copy of the
GNU Lesser General Public License along with this library; if not, write to the Free
Software Foundation, Inc., 59 Temple Place, Suite 330, Boston, MA 02111-1307 USA.
unRAR copyright: The decompression engine for RAR archives was developed using source
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and Iain S. Duff. All Rights Reserved. AMD License: Your use or distribution of AMD or any
modified version of AMD implies that you agree to this License. This library is free
software; you can redistribute it and/or modify it under the terms of the GNU Lesser
General Public License as published by the Free Software Foundation; either version 2.1 of
the License, or (at your option) any later version. This library is distributed in the hope
that it will be useful, but WITHOUT ANY WARRANTY; without even the implied warranty of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser
General Public License for more details. You should have received a copy of the GNU
Lesser General Public License along with this library; if not, write to the Free Software
Foundation, Inc., 51 Franklin St, Fifth Floor, Boston, MA 02110-1301 USA Permission is
hereby granted to use or copy this program under the terms of the GNU LGPL, provided
that the Copyright, this License, and the Availability of the original version is retained on
all copies.User documentation of any code that uses this code or any modified version of
this code must cite the Copyright, this License, the Availability note, and "Used by
permission." Permission to modify the code and to distribute modified code is granted,
provided the Copyright, this License, and the Availability note are retained, and a notice
that the code was modified is included. AMD Availability:
http://www.cise.ufl.edu/research/sparse/amd

UMFPACK 5.0.2 - UMFPACK Notice: The UMFPACK code was modified. Used by permission.
UMFPACK Copyright: UMFPACK Copyright © 1995-2006 by Timothy A. Davis. All Rights
Reserved. UMFPACK License: Your use or distribution of UMFPACK or any modified version
of UMFPACK implies that you agree to this License. This library is free software; you can
redistribute it and/or modify it under the terms of the GNU Lesser General Public License
as published by the Free Software Foundation; either version 2.1 of the License, or (at
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Fifth Floor, Boston, MA 02110-1301 USA Permission is hereby granted to use or copy this
program under the terms of the GNU LGPL, provided that the Copyright, this License, and
the Availability of the original version is retained on all copies. User documentation of any
code that uses this code or any modified version of this code must cite the Copyright, this
License, the Availability note, and "Used by permission." Permission to modify the code
and to distribute modified code is granted, provided the Copyright, this License, and the
Availability note are retained, and a notice that the code was modified is included.
UMFPACK Availability: http://www.cise.ufl.edu/research/sparse/umfpack  UMFPACK
(including versions 2.2.1 and earlier, in FORTRAN) is available at
http://www.cise.ufl.edu/research/sparse . MA38 is available in the Harwell Subroutine
Library. This version of UMFPACK includes a modified form of COLAMD Version 2.0,
originally released on Jan. 31, 2000, also available at
http://www.cise.ufl.edu/research/sparse . COLAMD V2.0 is also incorporated as a built-in
function in MATLAB version 6.1, by The MathWorks, Inc. http://www.mathworks.com .
COLAMD V1.0 appears as a column-preordering in SuperLU (SuperLU is available at
http://www.netlib.org ). UMFPACK v4.0 is a built-in routine in MATLAB 6.5. UMFPACK v4.3
is a built-in routine in MATLAB 7.1.

Qt Version 4.6.3 - Qt Notice: The Qt code was modified. Used by permission. Qt copyright:
Qt Version 4.6.3, Copyright (c) 2010 by Nokia Corporation. All Rights Reserved. Qt
License: Your use or distribution of Qt or any modified version of Qt implies that you agree
to this License. This library is free software; you can redistribute it and/or modify it under
the
terms of the GNU Lesser General Public License as published by the Free Software
Foundation; either version 2.1 of the License, or (at your option) any later version. This
library is distributed in the hope that it will be useful,
but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY
or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public License for
more details. You should have received a copy of the GNU Lesser General Public License
along with this library; if not, write to the Free Software Foundation, Inc., 51 Franklin St,
Fifth Floor, Boston, MA 02110-1301 USA Permission is hereby granted to use or copy this
program under the terms of the GNU LGPL, provided that the Copyright, this License, and
the Availability of the original version is retained on all copies.User
documentation of any code that uses this code or any modified version of this code must
cite the Copyright, this License, the Availability note, and "Used by permission."
Permission to modify the code and to distribute modified code is granted, provided the
Copyright, this License, and the Availability note are retained, and a notice that the code
was modified is included. Qt Availability: http://www.qtsoftware.com/downloads  Patches
Applied to Qt can be found in the installation at:
$HPEESOF_DIR/prod/licenses/thirdparty/qt/patches. You may also contact Brian
Buchanan at Agilent Inc. at brian_buchanan@agilent.com for more information.
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rights in and to the source code, is owned by Hiroshima University and/or STARC.
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Errata The ADS product may contain references to "HP" or "HPEESOF" such as in file
names and directory names. The business entity formerly known as "HP EEsof" is now part
of Agilent Technologies and is known as "Agilent EEsof". To avoid broken functionality and
to maintain backward compatibility for our customers, we did not change all the names
and labels that contain "HP" or "HPEESOF" references.

Warranty The material contained in this document is provided "as is", and is subject to
being changed, without notice, in future editions. Further, to the maximum extent
permitted by applicable law, Agilent disclaims all warranties, either express or implied,
with regard to this documentation and any information contained herein, including but not
limited to the implied warranties of merchantability and fitness for a particular purpose.
Agilent shall not be liable for errors or for incidental or consequential damages in
connection with the furnishing, use, or performance of this document or of any
information contained herein. Should Agilent and the user have a separate written
agreement with warranty terms covering the material in this document that conflict with
these terms, the warranty terms in the separate agreement shall control.

Technology Licenses The hardware and/or software described in this document are
furnished under a license and may be used or copied only in accordance with the terms of
such license. Portions of this product include the SystemC software licensed under Open
Source terms, which are available for download at http://systemc.org/ . This software is
redistributed by Agilent. The Contributors of the SystemC software provide this software
"as is" and offer no warranty of any kind, express or implied, including without limitation
warranties or conditions or title and non-infringement, and implied warranties or
conditions merchantability and fitness for a particular purpose. Contributors shall not be
liable for any damages of any kind including without limitation direct, indirect, special,
incidental and consequential damages, such as lost profits. Any provisions that differ from
this disclaimer are offered by Agilent only.

Restricted Rights Legend U.S. Government Restricted Rights. Software and technical
data rights granted to the federal government include only those rights customarily
provided to end user customers. Agilent provides this customary commercial license in
Software and technical data pursuant to FAR 12.211 (Technical Data) and 12.212
(Computer Software) and, for the Department of Defense, DFARS 252.227-7015
(Technical Data - Commercial Items) and DFARS 227.7202-3 (Rights in Commercial
Computer Software or Computer Software Documentation).

http://systemc.org/
http://systemc.org/
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 Using Instrument Connectivity
 

 Introduction
Transmitter wireless test benches support instrument connectivity. The following sections
explain how to connect to instruments and describe the test benches' compatibility with
Agilent Technologies instruments.

 

 Connecting to Instruments
 The wireless test benches rely on Connection Manager architecture for instrument
connectivity. Connection Manager is the implementation of Agilent Technologies
Connected Solutions for ADS.

A Connection Manager-based simulation is part of the client half of the Connection
Manager client/server system, and operates through an instance of the Connection
Manager server. You can think of the Connection Manager-based simulation as an
interface into the measurement available on the server.

Detailed information about using Connection Manager, including functional concepts and
server IO configuration is provided in Connection Manager (connectmui).

The Connection Manager architecture also provides instrument discovery and
measurement exploration.

 Discovery makes it easy to identify the instruments that are connected to your
server workstation, enabling the client to easily associate a particular instrument with
a particular measurement.
 Exploration locates measurements on the server and describes a measurement's
capabilities so a client can easily determine what a measurement does and how to
use that measurement.

  

 Instrument Discovery

 The transmitter test benches provide interactive selection of the instrument before
simulation. The Signal to ESG parameter category includes an Instrument parameter that
is set to a string following a specific syntax as shown in this example:
[GPIB::19::INSTR][localhost][4790]

To interactively select an instrument:

From the Wireless Test Bench component parameter dialog box, select the1.
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ESG_Instrument parameter.
Click the Select Instrument button to access the Set Server dialog box.2.

If Connect to server on remote Windows PC is selected, enter the IP address or DNS3.
name of the Windows PC on which an instance of the Connection Manager server is
running.
Enter the port number on which the server is waiting for incoming connection4.
requests. Unless the server settings are changed manually, use the default port
number 4790.
Click OK to access the Remote Instrument Explorer dialog box.5.

 This dialog box shows the Visa Resource identifiers of all instruments that are
currently connected to the workstation running the Connection Manager server. A
Visa Resource identifier is like an IP address that can uniquely identify an instrument
among all the instruments connected to the workstation through all available
interfaces.

To map the Visa Resource identifiers to the associated instrument model number,
select one or more of the Visa Resource entries and click the Query Instruments'
IDs button. This tells the Connection Manager server to send the standard IEEE
488.2 identification command *IDN? to the instrument(s). Most modern instruments
that understand this command will respond with an identification string. After all
selected instruments are queried, the Instrument IDs are displayed:
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Select a specific instrument based on the Instrument ID string displayed and click OK.6.

  

 Compatibility with Agilent Technologies Instruments
WLAN test benches, signal sources, and EVM measurements are compatible with the
Agilent E4438C ESG Vector Signal Generator, and Agilent 89600 Series Vector Signal
Analyzer; details are given in the following table.

 WLAN Agilent Instrument Compatibility Information

WLAN Spec ESG Models VSA Models

SpecVersion= 1999 E4438C, Firmware Revision C.03.40
Option 417 - "802.11 WLAN"
Software Personality (Signal Studio)

89600 Series, software version 4.xx/5.xx
Option B7R - "WLAN Modulation Analysis"

TD-SCDMA test benches and signal sources are compatible with Agilent E4438C Signal
Generator and Agilent 89600 Series Vector Signal Analyzer; details are given in the
following table.

 TD-SCDMA Agilent Instrument Compatibility Information

TD-SCDMA Spec ESG Models VSA Models

SpecVersion= 6-2002 E4438C, Firmware Revision C.03.40
Option 411 - "TD-SCDMA (TSM)"
Software Personality (Signal Studio)

89600 Series, software version 4.xx/5.xx
Option B7N - "3G Modulation Analysis"

3GPP FDD test benches and signal sources are compatible with Agilent E4406A VSA Series
Transmitter Tester, Agilent PSA Series High-Performance Spectrum Analyzer, and Agilent
89600 Series Vector Signal Analyzer; details are given in the following table.

 3GPP FDD Agilent Instrument Compatibility Information
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3GPP Spec ESG Models VSA Models

SpecVersion= 3-
2002

E4438C, Firmware Revision C.03.40
Option 400 - "3GPP W-CDMA FDD"
Personality

E4406A, Firmware Revision A.06.03
Option BAF - "W-CDMA" Measurement
Personality
PSA, Firmware Revision A.04.07
Option BAF - "W-CDMA" Measurement
Personality
89600 Series, software version
3.01/4.xx/5.xx
Option B7N - "3G Modulation Analysis"

For more information about Agilent ESG Series of Digital and Analog RF Signal Generator
and Options, visit
www.agilent.com/find/ESG .
For more information about Agilent PSG Series of Digital and Analog RF Signal Generator
and Options, visit
www.agilent.com/find/PSG .
For more information about Agilent 89600 Series Vector Signal Analyzer and Options, visit
www.agilent.com/find/89600 .
For more information about Agilent PSA series High-Performance Signal Analyzer and
Options, visit
www.agilent.com/find/psa
 

http://www.agilent.com/find/ESG
http://www.agilent.com/find/ESG
http://www.agilent.com/find/PSG
http://www.agilent.com/find/PSG
http://www.agilent.com/find/89600
http://www.agilent.com/find/89600
http://www.agilent.com/find/psa
http://www.agilent.com/find/psa
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 Using Wireless Test Bench Models
 

 Introduction
Wireless test bench simulation is used to perform complex wireless system measurements
using wireless test bench models. 3GPP FDD, EDGE, HSUPA, Mobile WiMAX, TD-SCDMA,
Ultra-Wideband, and WLAN Wireless Design libraries provide pre-configured models as
well as templates.

 WTB simulation uses Circuit Envelope analysis along with the ADS Ptolemy Data Flow
(DF) controller to perform Analog/RF and system cosimulation. Each wireless test bench
model is packaged such that the RF designer avoids working with DF analysis parameters.

  

 Working with WTB Template
WTB Template is the starting point of the WTB simulation.

To insert a WTB template:

In an Analog/RF schematic window select Insert > Template.1.
In the popup Insert Template dialog box, choose one of the installed WTB templates,2.
for example 3GPPFDD_BS_TX_test, click OK.

Click left to place the template in the schematic window.3.
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You are now ready to replace the DUT with your own RF design, select measurements,
and set parameters. See Setting Circuit Envelope Analysis Parameters, and Setting up a
Wireless Test Bench Model.

 

 Setting up a Wireless Test Bench Model
Replace the Amplifier2 DUT with your own RF DUT, set the required parameters, and set
optional parameters as necessary. The required parameters include setting simulation
frequencies and selecting measurements; at least one measurement must be enabled for
successful simulation. Optional parameters provide additional control of the selected
measurements. These topics are discussed in the following sections:

Setting Required Parameters

Setting Optional Model Parameters

The following table describes the various types of parameter data entry fields in
parameter dialog boxes.
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Parameter Field
Type

Description

String data entry
field

Used to enter integer, real, complex, or string type of scalar data. Array and string type
data must be enclosed in quotes.

String data entry
field with multiple
choices

This gives you multiple choices for the value of the parameter to select from. The pull
down list field also enables you to type in the data directly. The last choice in the list
specifies what the type-in value can be, such as an option index, a real value, etc. Use this
mode to assign a variable to this type of parameter; then use the variable to either sweep
or optimize the parameter.

Information fields This non-editable information field provides information on a certain aspect of the WTB
model.

Instrument
selection field

This is a string data entry field followed by a button to launch the instrument-selection
user interface. This type of parameter is used only when you enable ESG download. You
can enter the instrument address directly or use the button to launch the instrument-
selection user interface to interactively select the instrument and update the address.

 

 Setting Required Parameters
 After connecting the WTB model and DUT ports, double click on the WTB component to
set the Required Parameters in the popup parameter dialog box. The number of
parameters varies between different models. These parameters control the simulation and
identify the selected measurements. They must have valid values and cannot be left
blank. For detailed information about setting these parameters, click Help in the
parameter dialog box.

Note
You must set the required frequencies and select at least one measurement for successful simulations.

 

 Setting Circuit Envelope Analysis Parameters

 The WTB analysis is a cosimulation between an Env (Circuit Envelope) analysis and a
DataFlow analysis to verify an RF design's system performance. The DataFlow analysis is
pre-configured with the WTB model.

The RF designer must configure the Circuit Envelope analysis to ensure proper simulation.
For details about setting the Circuit Envelope parameters, see Envelope Simulation
Parameters (cktsimenv).

Simulation stop time is controlled by the selected measurements and their parameter
values. The measurements and their parameters are located after the Required
Parameters. If necessary for your measurement requirements, set the optional
parameters for the WTB model. See Setting Optional Model Parameters.

  

 Setting Fast Cosimulation Parameters
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 When the Circuit Envelope controller dialog box is open, choose the Fast Cosim tab.
Select Enable Fast Cosim to gain access to and set its parameters. Fast Cosim is also
known as Automatic Verification Modeling (AVM).

Fast Cosim is a user-selected mode of operation, available for co-simulation that can
significantly speed up Circuit Envelope simulations of Analog/RF circuits. When this mode
is enabled, the analog subcircuit is characterized using a variety of Harmonic Balance
simulations at the start of each wireless test bench simulation. During the actual wireless
test bench simulation, this characterization data is then used to predict the response of
the subcircuit instead of performing the full circuit simulation at each time point.

Since this characterization is normally done at the start of each WTB analysis sweep based
on the full circuit level schematic, the overall capability is basically the same as if the
actual circuit level representation is used throughout the Circuit Envelope simulation. For
example, optimization of circuit level parameters, or swept parameters including bias,
temperature or swept carrier frequency, will continue to operate as expected. These
capabilities do not exist when the circuit is manually replaced with behavioral models.

This ability to predict the modulated response based on the Harmonic Balance
characterization relies on the fact that many circuits, when used in relatively narrow band
modulated applications, can have their nonlinearity represented as a static nonlinearity
that is strictly a function of the instantaneous amplitude of the carrier. Many of these
circuits (amplifiers and mixers) have little or no frequency response over the modulation
bandwidth of interest; any frequency response effects that do exist can often be
represented as a linear filter on the input or output of the nonlinearity.

Each output of the Analog/RF subcircuit is then characterized by the equation:

The Pk( mag ) functions are determined by the swept amplitude Harmonic Balance

simulation. The HarmGain is the harmonic gain determined from the harmonic indices of
the input and output frequencies.

If phase characterization has been enabled (setting the Num. of phase pts parameter to a
non-zero value) each output is then characterized by this modified equation:

In this case, Pk( mag, phase ) functions are determined by a 2D swept amplitude and

swept phase Harmonic Balance simulation.

If the subcircuit nonlinearities are a function of the input phase, as in a nonlinear IQ
demodulator, then the amplitude-only characterization is not accurate and the 2-
dimensional amplitude and phase characterization must be used.

Note that the magnitude-only characterization assumes the output phase can be
determined from the harmonic indices of the input and output frequencies. In certain rare
cases, this can be ambiguous. For example, if the input frequency is fund1 and the output
frequency is 2*fund1, then the simulator assumes the output signal is generated by
doubling the input frequency and so the input phase is doubled. However, if this 2*fund1
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output frequency is actually generated by mixing with another LO source at the fund1
frequency and the phase relationship is supposed to be linear, then the Fast Cosim results
will be incorrect. If the mixer LO is operating at an independent fund2 frequency, with a
mixer output at fund1 + fund2, then the HarmGain of 1.0 is correctly determined. So, as
with the IQ demodulator, if there are circuit sources operating at the same frequency as
the input signal, caution must be used when enabling this Fast Cosim mode, and the 2D
amplitude and phase characterization may be required.

In addition to the swept amplitude characterization, the Fast Cosim characterization also
includes a small signal Harmonic Balance frequency sweep. In this case, the input
amplitude is set to 0, and the small signal frequency is swept between +/- 0.5/ TimeStep.
Note that even though the input amplitude is set to 0, a nonlinear analysis is still being
done so any frequency translation effects due to internal mixers will be fully captured. An
impulse response representing this frequency response can then be generated and placed
(at the user's choice) on the input or the output of the nonlinear block. An additional delay
can be added to the frequency response, so that the impulse can be made a more
accurate representation of the frequency response. The user should set the number of
frequency points high enough that any frequency response deviations are sufficiently
sampled (a minimum of 4 samples every 360 degrees). The maximum duration of the
impulse response will be approximately 0.75/ FreqSpacing, where

N is determined so that 2N is just larger than the user-specified number of frequency
points.

In addition to the amplitude and frequency response characterization, nonlinear noise
characterization is also done. A single value for the equivalent input noise for each output
is determined, then added to the input signal prior to the above nonlinear and frequency
response effects. In the case of multiple outputs, these equivalent noise sources are
uncorrelated. So any correlation of the Analog/RF subcircuit added noise between multiple
outputs is lost during this Fast Cosim mode. This noise characterization is implemented by
selecting Turn On All Noise in the Envelope parameter group in the Options window.
Normally, the frequency points used for noise characterization are the same as for small-
signal response characterization in which a linear frequency sweep is used. Such a linear
frequency sweep may require too many frequency points to properly capture narrow band
noise such as 1/f noise. To handle 1/f noise characterization efficiently you can choose to
set an independent log sweep on the Envelope controller's Fast Cosim tab in the
Characterization Options.

In certain cases, the time spent doing this characterization can be eliminated if the user
requests that the simulator use previous characterization. Once this mode is selected,
then the user must make sure that the previous characterization is still valid, and that
circuit parameters have not been changed (perhaps by optimization), biases have not
changed, carrier frequencies have not changed, etc. The circuit should not have changed
its connectivity within the WTB analysis environment. Also, the format and data in the
dataset must be in the same expected configuration as when it was written by simulator.

In addition to the characterization and implementation portion of the Fast Cosim mode,
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there is also a user-selectable verification step. If the user specifies a non-zero verification
Stop Time, then the normal Circuit Envelope simulation is performed in parallel with the
fast cosimulation predictions. The error over this verification is then calculated and output
to determine how well these predictions are performing. If the behavior is unacceptable,
as determined by the Accept Tolerance, then the Fast Cosim will be disabled and only the
normal Circuit Envelope results will be used. Clearly, if used, this verification time should
be set long enough to include a representative portion of the input signal. This may need
to take into account the fact that many sources, due to channel filtering, take a while to
generate their full amplitude outputs.

 

 Limitations

 While you may have selected the Fast Cosim mode, it may become disabled if:

The RF DUT has more than one input from the WTB model or the input is not for an
RF signal (non-zero carrier frequency).
The Circuit Envelope Step is not an integer submultiple of the WTB_TimeStep. See
the specific WTB documentation to understand how the WTB_TimeStep is set.
WTB_TimeStep cannot be set directly by the user and is set by derivation from the
other WTB model parameters.
Verification was enabled but performance did not meet an acceptance level.
The Envelope analysis includes an oscillator analysis.
The input frequency was a mixing term and not harmonically related to a single
fundamental.
The input frequency does not exactly match an Envelope analysis frequency.
There was a problem reading the previously generated dataset.

Fast Cosim is not available for use with WTBs performaing Power Added Efficiency
measurements.

Additional limitations of the Fast Cosim mode, that may not be automatically detected by
the simulator unless verification is enabled, include:

Envelope analyses parameters such as the Freq parameters should not be swept or
optimized.

 

 Setting Optional Model Parameters
 The optional WTB model parameters are listed after Required Parameters in the
parameter dialog box. Scroll down to see all of the parameters. Some parameters control
the simulation run time, which you will use primarily to modify the simulation run time;
otherwise, you rarely need to modify them.

Some parameters are for measurements listed in Required Parameters. Some of those
parameters will also control the simulation run time. You may need to change parameters
for the measurements you have selected.
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For detailed information about setting these parameters, click Help in the parameter
dialog box.

 

 Performing Sweeps, Monte Carlo/Yield Analysis, and
Optimizations
 WTB model parameters can be included in Parameter Sweep, Monte Carlo/Yield Analysis,
and Optimization Analysis.

Note
The SimInstanceName must always use "WTB1" for sweep or optimization controller regardless of the
Envelope controller's instance name.

For information about Parameter Sweeps, see Parameter Sweeps and Sweep Plans
(cktsim) in the Using Circuit Simulators (cktsim) documentation.

For information about Monte Carlo/Yield Analysis and Optimizations, see Using Monte
Carlo Yield Analysis (optstat) in the Tuning, Optimization, and Statistical Design (optstat)
documentation.
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 Viewing WTB Analysis Results
 

 Introduction
You can view Wireless Test Bench measurement results immediately after a simulation is
complete, or view results on previous collected datasets. For more information about
using the data display, see the Data Display (data) documentation.

Note that a Wireless Test Bench (WTB) simulation in ADS consists of an Envelope
controller on the top level, and a DF controller embedded in the hierarchy. You may notice
that the dataset entries resulting from a WTB simulation differ from those expected from a
Circuit Envelope simulation.

In a normal Circuit Envelope simulation, time and freq are in the dataset. Neither is
present in a WTB simulation, even though an Envelope controller is on the top level
schematic. This is because a WTB simulation is really a Ptolemy/Envelope cosimulation, so
the independent variables will be time for timed signals and Index for numeric signals.
The following example workspace includes some examples of dataset entries:

Workspace: WCDMA3G_RF_Verification_wrk

Design: 3GPPFDD_UE_TX_test

RF_V.WTB.time (indep var: time)
Meas_V.WTB.time (indep var: time)
RF_Power.CCDF.CCDF.WTB.Index (indep var: Index)
WTB1.WTB.time is a dummy variable, which has a value of 0 sec.

  

 Viewing Simulation Results
 You can view the results of a WTB simulation in the following two ways:

At the end of a simulation a data display window automatically opens containing the
measurement results.
For simulation data collected earlier, build customized data display.
 
Each successful WTB simulation dataset contains information on the data display
pages to display at the end of a simulation when Open Data Display when simulation
completes is enabled (default). In this case, the opened data display window contains
the various pages set up for every measurement enabled in the Wireless Test Bench
Setup form.

To enable Open Data Display when simulation completes:
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In the Analog RF schematic window, select Simulate > Simulation Setup.1.
In the Simulation Setup dialog box, enable the options Open Data Display when2.
simulation completes.

To build a customized data display, pre-defined WTB data display template can be used:

In the Data Display window, select Insert > Template.1.
In the Component Library/Template Browser window, click on libraries DDS2.
Templates - Product, then choose an appropriate data display template, for
example, 3GPPFDD_BS_TX_Power.
Click OK to insert selected data display template. Multiple data display templates can3.
be inserted one by one sequentially.

Note
The automatically opened data display and the inserted data display template usually contains
multiple data display pages. Use View Previous Page or View Next Page toolbar buttons to
explore all pages.
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 Wireless Measurement Definitions
 

 Introduction
The following sections briefly describe the most commonly used measurements in
transmitter and receiver testing for WLAN, TD-SCDMA, and 3GPP FDD.

Transmission Test Measurements
RF Envelope
Constellation
Power
Spectrum
EVM

Receiver Test Measurements
BER Measurements
Eb/No Definition

RF Power Amplifier Measurements
Power Added Efficiency Measurements

  

 Transmission Test Measurements
  

 RF Envelope

The RF envelope measurement shows the magnitude of the RF signal's envelope versus
time. By observing a signal's RF envelope versus time you can see the signal's
frame/burst structure. Some wireless standards specify a mask, to which the signal's RF
envelope must conform. The mask is typically specified during the ramp up and ramp
down transient of the signal.

  

 Constellation

The constellation measurement shows in a graphical way the general quality of a signal.
For a more accurate measurement of a signal's modulation quality an EVM analysis must
be performed.

A constellation measurement is most appropriate when a QAM modulation scheme is used
(directly or indirectly; for example WLAN 802.11a uses OFDM modulation, where a set of
subcarriers is modulated using some QAM scheme). An ideal QAM signal will have a
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constellation that consists of a set of distinct points on the IQ plane. The following figure
shows the constellation for an ideal 16-QAM signal. This constellation has 16 points and is
symmetric around the X and Y axes. All points are equally spaced.

 

 Constellation for Ideal 16-QAM Signal

Different signal distortions modify the ideal constellation in different ways and so by
looking at the constellation you can get some idea of what types of distortions are present
in the signal. The following five illustrations show some examples of how signal distortions
appear in the constellation.

The following figure shows the constellation for a 16-QAM signal with gain imbalance. This
can be deduced by the fact that in the ideal constellation the span of the points across
both axes is the same (approximately 0.425), whereas in the constellation with the gain
imbalance the Y axis has a bigger span (approximately 0.475).
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 Constellation for 16-QAM Signal with Gain Imbalance

The following figure shows the constellation for a 16-QAM signal with phase imbalance.
This can be deduced by the fact that in the ideal constellation the points are lined up
parallel to the X and Y axes, whereas in the constellation with the phase imbalance the
points are lined up parallel to the X axis but not to the Y axis.

 

 Constellation for 16-QAM Signal with Phase Imbalance

The following figure shows the constellation for a 16-QAM signal with ISI (intersymbol
interference) and AWGN (additive white gaussian noise). Notice that instead of 16 distinct
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points there are 16 clusters of points centered around the ideal 16-QAM points.

 

 Constellation for 16-QAM Signal with ISI and AWGN

The following figure shows the constellation for a 16-QAM signal with gain compression
(from a nonlinear amplifier). Notice how the outer points (especially the four corner
points) that have the highest power have been compressed (moved closer to the center of
the IQ plane).

 

 Constellation for 16-QAM Signal with Gain Compression
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The following figure shows the constellation for a 16-QAM signal that includes all of the
distortions discussed above.

 

 Constellation for 16-QAM Signal with Multiple Types of Distortion

  

 Power

The power measurement is a set of power-related measurements that provides
information about a signal's statistical properties. The power measurement includes:

Power vs. Time shows the instantaneous signal power versus time. Some wireless
standards specify a mask, to which the signal's instantaneous power versus time
waveform must conform. The mask is typically specified during the ramp- up and
ramp-down transient of the signal.
Total (Average) Power is the average signal power over the measurement duration.
For signals that are transmitted in bursts or in slots this measurement should be
performed only when the signal is active (on) and not during the idle intervals or
inactive slots.
Peak Power is the maximum instantaneous signal power over the measurement
duration. Some standards define the peak power not as the absolute maximum
instantaneous signal power but as the power level that is exceeded only for a small
percentage (e.g. 1%) of the time.
Peak to Average Ratio is the ratio of the peak signal power to the average signal
power.
Power Complementary Cumulative Distribution Function is defined as CCDF = 1 -
CDF, where CDF is the cumulative distribution function of the signal's instantaneous
power. If the probability density function of the signal's instantaneous power is p(x),
then
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The power CCDF curve shows the probability that the instantaneous signal power will
be higher than the average signal power by a certain amount of dB. The X axis of the
CCDF curve shows power levels in dB with respect to the signal average power level
(0 dB corresponds to the signal average power level). The Y axis of the CCDF curve
shows the probability that the instantaneous signal power will exceed the
corresponding power level on the X axis.

The following figure shows the CCDF curve for a WLAN 802.11a 54 Mbps signal. In
the figure, you can see that the instantaneous signal power exceeds the average
signal power (0 dB) for approximately 20% of the time. You can also see that the
instantaneous signal power exceeds the average signal power by 5 dB for only 0.7%
of the time.

For signals that are transmitted in bursts or in slots this measurement should be
performed only when the signal is active (on) and not during the idle intervals or
inactive slots.

 

 Power CCDF Curve for a WLAN 802.11a 54 Mbps Signal

Code Domain Power (CDP)

For signals that use Code Division Multiple Access (CDMA) techniques, CDP is another
useful power measurement. CDP shows the distribution of the signal's power in the
code domain. The following figure shows the results of a CDP measurement for a
3GPP FDD Test Model 3 signal (based on 2000-12 version of the standard) with 16
DPCHs.
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 CDP Measurement for 3GPP FDD Test Model 3 Signal with 16 DPCHs

In the preceding figure, you can clearly see the 16 active DPCHs (occupying codes in the
64 to 128 range), as well as the primary CPICH (code 0), the P-CCPCH+SCH (code 1), and
the PICH (code 16).

  

 Spectrum

The spectrum measurement shows the spectrum of a signal that is the distribution of the
signal's power in the frequency domain. Most wireless standards specify a mask, to which
the signal's spectrum must conform. The need for the transmitted signal spectrum to
conform to a spectral mask is so that the interference to adjacent channels is minimized
and kept at acceptable levels. The following figure shows an example of a spectrum
measurement and a spectral mask for a WLAN 802.11a signal.
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 Spectrum Measurement and Spectral Mask for WLAN 802.11a Signal

Some wireless standards specify additional spectrum related measurements. For example,
the 3GPP FDD standard defines the following spectrum measurements:

Adjacent channel leakage ratio (ACLR) is the ratio of the transmitted power to the
power measured after a receiver filter in the adjacent channel(s).
Occupied Bandwidth is the bandwidth that contains 99% of the signal's total
transmitted power. The bandwidth is centered around the channel frequency so that
the total power outside this bandwidth is split equally (0.5% of the total transmitted
power) between the bands below and above it. The following figure shows the
definition of the occupied bandwidth.
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 Occupied Bandwidth Definition

  

 EVM

The EVM (error vector magnitude) measurement provides a metric for the modulation
quality/accuracy of a signal. EVM is a measure of the difference between the measured
signal and an ideal reference signal. While EVM may be defined differently in each wireless
standard, the basic concept is described here.

Let S(k), k = 1, ..., N, be the ideal transmitted signal sampled at one sample per symbol
(or chip) at the optimal (zero-ISI) instance. The actual transmitted signal can be modeled
as

where:

W = e Dr+jDa, accounts for both a frequency offset (Da radians/symbol phase
rotation) and an amplitude change rate (Dr nepers/symbol)
C0 is a complex constant representing origin offset

C1 is a complex constant representing the arbitrary phase and output power of

the transmitter
E(k) is the residual vector error on sample S(k)

The sum square error vector is

where C0, C1, W are chosen such as to minimize the above expression.

EVM (rms) is defined to be the rms value of |E(k)| normalized by the rms value of |S(k)|.
Therefore,



Advanced Design System 2011.01 - Wireless Test Bench Simulation

29

In addition to the EVM rms value, the EVM analysis provides other useful results, such as:

Peak EVM
Symbol (or chip) where the peak EVM occurs
rms magnitude error (difference between the magnitudes of the ideal and reference
signals)
Peak magnitude error
Symbol (or chip) where the peak magnitude error occurs
rms phase error (difference between the phases of the ideal and reference signals)
Peak phase error
Symbol (or chip) where the peak phase error occurs
Frequency error
IQ offset (some wireless standards do not remove IQ offset from the measured signal
and so this type of distortion is included in the EVM value)

For signals that use code division multiple access (CDMA) techniques, peak code domain
error (PCDE) is another useful measurement related to EVM. To get the PCDE value, the
error vector E(k) is first projected on the code domain. This is done by calculating the
inner-product between E(k) and all the orthogonal vectors in the channelization code set
(all codes belonging to the one spreading factor). Then the maximum projection is
selected and normalized by the rms value of the reference signal.

  

 Receiver Test Measurements
 

 BER Measurements

 A receiver's performance is determined by its ability to receive and demodulate a wanted
signal in the presence of noise and/or other interfering signals. Although there are several
measurements used to test a receiver's performance, all of them measure the same
quantity under different conditions. The measured quantity is the bit error rate. BER is the
probability that a transmitted bit will be received and detected in error. Of course, better
receivers have a lower BER.

 Different wireless standards give different names to various BER measurements such as:
Minimum Input Power Sensitivity, Minimum Input Level Sensitivity, Adjacent Channel
Rejection, Adjacent Channel Selectivity, Reference Sensitivity Level, Dynamic Range,
Blocking, Intermod. As mentioned earlier, all the above measurements are BER
measurements under different conditions. These different conditions include additive white
gaussian noise (AWGN), modulated interference signals, and CW interference signals. The
interference signals can be in band and/or out of band. Typically, the standards specify
that the BER should not exceed a certain value for certain power levels of the wanted and
interfering signals, and a certain frequency offset (between the wanted signal's channel
frequency and the frequency of the interfering signals).



Advanced Design System 2011.01 - Wireless Test Bench Simulation

30

  

 Eb /No Definition

 Bit error rate (BER) and frame and packet error rate (FER/PER) are typically reported
with respect to Eb /No. This note defines Eb /No and relates it to signal to noise ratio

(SNR). Distinction is made of local and system Eb /No. The following discussion is based on

similar discussions published by Bernard Sklar (see Eb/No References).

For this discussion, the following figure illustrates a typical RF comm system receiver block
diagram.

 

 Typical RF Comm System Receiver Block Diagram

In the diagram above:

The initial two blocks represent the transmitted signal and the propagation channel
between the transmit and receive antennas. The transmitted signal contains data
with bit time Tb with bit rate R bits/sec. The propagation channel includes significant

attenuation and propagation effects (phase, amplitude, multi-path fading, etc.).
A is the receiver antenna output.
B is a mid point within the receiver system.
C is the receiver system pre-detection point.
RX DUT 1 is the receiver RF frontend and contains any lossy lines before the receiver
and receiver front-end amplifiers, filters, and mixers. For this discussion it is defined
with gain in dB (G1 ) and noise figure in dB (NF1 ).

RX DUT 2 is the receiver backend and contains content before detection and includes
amplifiers, filters, matched filter, and sampler. For this discussion it is defined with
gain in dB (G2 ) and noise figure in dB (NF2 ).

BER is then measured, typically with suitable DSP algorithms.

 At each A, B, and C point in the system, there is a measurable value for the signal (SA, SB

, SC ) and noise density (NOA, NOB, NOC ), where the signal is in Watts (W) and noise

density is in Watts/Hz (W/Hz).
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 In this system (and for discussion purposes) the received desired signal has additive
thermal noise contributions from the propagation path available at the receiver antenna
output and from the receiver noise figures. Other noise contributors are ignored, such as
interfering signals and nonlinear intermodulation products.

Thermal noise at the receiver antenna output is typically defined in terms of noise
temperature in Kelvin. Call this TA. Note that 290 K (16.85o C) corresponds to a noise

power density of -173.975 dBm/Hz value.

The receiver antenna output noise power density is:

N0A = k Ta, where k is Boltzmann's constant.

Receiver noise figures can also be represented in terms of noise temperature in Kelvin: T
= 290 (F-1) where F = 10(NF/10).
The RF DUT 1 and 2 have associated noise temperatures at T1 and T2 respectively.

T1 = 290 (F1 -1); F1 = 10(NF
1 {^}/10)

{} T
2
 = 290 (F

2
 -1); F

2
 = 10(NF{} 2 {}/10){^}

T1 represents the equivalent noise temperature due to RF DUT 1 defined at the input of RF

DUT 1 and has associated noise power density: k T1. This results in definition for N0B as:

N0B = G1 (k Ta ) + G1 (k T1 ) = G1 k (Ta +T1 )

T1 represents the equivalent noise temperature due to RF DUT 2 defined at the input of RF

DUT 2 and has associated noise power density: k T2. This results in definition of N0C as:

N0C = G1 G2 (k Ta ) + G1 G2 (k T1 ) + G2 (k T2 ) = G1 G2 k (Ta +T1 +T2 /G2 )

 SNR is related to Eb /No in the following way:

where:

SNR = signal-to-noise ratio (unitless)
S = signal power (W)
N = noise power (W)
Eb = bit energy (W / sec)
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Tb = bit time (sec)

NBW = receiver noise bandwidth (Hz)

N0 = noise power density = N / NBW (W/Hz)

R = data rate = 1/ Tb (1/sec)

Eb /N0 = Eb over N0 (unitless)

To provide a signal-to-noise figure that is independent on the receiver noise bandwidth,
the signal-to-noise density is typically used.

Thus, we now see the relationship between Eb /N0 and S/No and S/N.

S/No and Eb /N0 values may be considered as local or system values. Local values are

specific to the receiver system point where they are evaluated (points A, B, or C in the
diagram); system values are independent of the receiver system point where they are
evaluated.

Local values of S/No and Eb /N0 are directly measurable at each point in the system and

are typically the preferred S/No and Eb /N0 values used by RF/analog designers.

At points A, B, and C, the local S/No values are:

SA /NOA = SA /(k Ta )

SB /NOB = (SA G1 )/(k (Ta +T1 ) G1 ) = S1 /(k (Ta +T1 ))

SC /NOC = (SA G1 G2 )/(G1 G2 k (Ta +T1 )+G2 k T2 ) = SA /(k (Ta +T1 +T2 /G1 )

System values of Eb /N0 and S/No are directly measurable only at the pre-detection

system point (point C in the diagram). These are the system values because they
characterize the overall system performance. The system values are typically the
preferred S/No and Eb /N0 values used by System/DSP designers.

In all cases,

E  /N  = S/N  /R



Advanced Design System 2011.01 - Wireless Test Bench Simulation

33

b 0 o

At point C, the local Eb /N0 and S/No values are the same as the system Eb /N0 and S/No

values.

 

 Summary

Local S/No and Eb /N0 values are not the same at all points of measurement in the

receiver.
System S/No and Eb /N0 values are only measurable at the receiver pre-detection

point (point C in the diagram), may be inferred at the other receiver points (points A
and B) and have only one value defined for the system.
Always specify if the S/N0 or Eb /No you are using is the Local or the System value.

In the Wireless Test Bench data displays, the Eb /No value used is the local Eb /No value at

the receiver input, equivalent to point A in the diagram.

 

 Eb /No References

Sklar, Bernard, Digital Communications: Fundamentals and Applications, 2nd Edition,1.
Prentice-Hall, N.J., 2001.
Sklar, Bernard, "RF Resign: Will the Real Eb /No Please Stand Up," Communication2.

Systems Design, April, 2003.

  

 RF Power Amplifier Test Measurements
 

 Power Added Efficiency (PAE) Measurements

In an RF power amplifier (PA), power added efficiency (PAE) is defined as the ratio of the
difference of the output and input signal power to the DC power consumed. In other
words:
PAE = (PRFOUT - PRFIN)/PDC
where:
PRFOUT = the RF PA output power delivered
PRFIN = the RF PA input power consumed
PDC= the RF PA input DC power consumed

For an RF wireless signal, the PAE is measured only during the time interval when the
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wireless signal is 'ON'. A wireless signal typically has a frame format and often at some
time during that frame the wireless signal power is zero, or some low level, that is not
representative of the high power mode of the signal frame. The PAE value typically of
interest is that value that occurs during the high power mode in the signal frame. Not all
wireless technologies use the word 'frame' to represent their formatted signal segment.
The word 'frame' here is use to mean 'burst', 'slot', 'subframe' or other nomenclature that
is specific to a wireless technology. The frame based PAE measurement is made only
during specific time gated time intervals within the signal frame.

 

 References
Agilent Application Note "Characterizing Digitally Modulated Signals with CCDF1.
Curves."
http://literature.agilent.com/litweb/pdf/5968-6875E.pdf
Agilent PN (Product Note) "Using Error Vector Magnitude Measurements to Analyze2.
and Troubleshoot Vector-Modulated Signals."
http://literature.agilent.com/litweb/pdf/5965-2898E.pdf

 

http://literature.agilent.com/litweb/pdf/5968-6875E.pdf
http://literature.agilent.com/litweb/pdf/5968-6875E.pdf
http://literature.agilent.com/litweb/pdf/5965-2898E.pdf
http://literature.agilent.com/litweb/pdf/5965-2898E.pdf
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 Wireless Test Bench Basics
 

 Introduction
 ADS wireless test benches enable system designers to make wireless system
measurements available to RF designers to validate RF designs for use with wireless
systems.

Previously, RF designers used traditional Analog/RF measurements such as spectrum, TOI,
etc. to validate their designs. Empirical methods used to map Analog/RF measurements to
determine wireless system performance were error prone. Typically, they could not
perform more complex wireless system measurements successfully such as EVM and BER.
And, a system designer using ADS Ptolemy simulator could not easily deliver a system
test bench to the RF designer for more accurate and complete RF verification.

Wireless test bench templates available in the Analog/RF schematic provide easy access to
pre-configured ADS WTB models (the models are complete, so the RF designer does not
need to know internal test bench details). By simply inserting a WTB template the RF
designer need only replace Amplifier2 with their RF DUT, specify test bench test frequency
and/or power levels, and rely on the other default settings.

WTB models are provided for RF transmitter, RF receiver, and RF power amplifier testing.
Transmitter test models provide standards-specific wireless transmitter tests such as
constellation, CCDF, and EVM. Transmitter models can be linked to Agilent signal
generator test instruments to further enable designers to use the same test signals from
the WTB models to test their RF designs as well as hardware prototype of their RF
designs. Receiver test models provide standards-specific wireless receiver tests such as RF
sensitivity. RF power amplifier test models provide tests such as power added efficiency
that take into account the wireless signal frame structure and signal power gating
characteristics.

The RF designer typically should use the WTB analysis after doing traditional
measurements to achieve an acceptable performance from the RF designs. In the initial
design stages the RF designer may have to stimulate the design with proper wireless
standard signals.

Wireless sources are provided under Analog/RF Sources-Modulated-DSP-based library.
These are configurable source components and their use model is similar to power sources
such as P_1Tone; and, they can be used in different analyses such as Circuit Envelope,
and S-parameter just like other sources.

 Wireless sources generate RF signals that can be used in traditional simulations.
Additionally, these can be used for wireless system measurements, such as WLAN EVM,
using the set of wireless expressions. These wireless expressions can be used in MeasEqn
block. For more complex receiver measurements, such as BER, you must use the wireless
test bench models using the WTB analysis.
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The wireless sources and expressions are useful in the initial phases of the RF
development for traditional Analog/RF measurements. As the design matures, the RF
designer must use WTB analysis and the corresponding wireless test bench models for
more complete transmitter and transmitter system verification.

 

 Wireless Test Bench Models

The following table lists the pre-configured wireless test bench models. These test benches
provide comprehensive transmitter and receiver testing for 3GPP FDD, TD-SCDMA, and
WLAN technologies. All measurements are performed according to wireless technology
industry standard specifications. For details about using these models, see the online
documentation:

3GPP FDD Wireless Test Benches (adswtb3g)

EDGE Wireless Test Benches (edgewtb)

HSUPA Wireless Test Benches (adswtbhsupa)

Mobile WiMAX Wireless Test Benches (adswtbwman_m)

RF Power Amplifier Test Benches (rfpwrampwtb)

TD-SCDMA Wireless Test Benches (adswtbtds)

UWB Wireless Test Benches (adswtbuwb)

WLAN Wireless Test Benches (adswtbwlan)

 

 Wireless Test Bench Models

WTB Model Measurements ESG Link

 3GPPFDD_BS_TX:
3GPP FDD Base Station Transmitter Test

RF Envelope
Power
ACLR
Occupied Bandwidth
CDP
PCDE
EVM

Signals can be sent to
an ESG

 3GPPFDD_UE_TX:
3GPP FDD User Equipment Transmitter Test

RF Envelope
Power
ACLR
ACLR in Switching
Transients
Occupied Bandwidth
CDP
PCDE

Signals can be sent to
an ESG
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EVM

 3GPPFDD_BS_RX:
3GPP FDD Base Station Receiver Test

Reference Sensitivity Level
Dynamic Range
Adjacent Channel Selectivity
Blocking Characteristics
Intermodulation
Characteristics

 

 3GPPFDD_UE_RX:
3GPP FDD User Equipment Receiver Test

Reference Sensitivity Level
Maximum Input Level
Adjacent Channel Selectivity
Blocking Characteristics
Intermodulation
Characteristics

 

 3GPPFDD_RF_PAE:
3GPP FDD RF Power Amplifier Test

Power Added Efficiency  

 EDGE_RF_PAE:
EDGE RF Power Amplifier Test

Power Added Efficiency  

 HSUPA_UE_TX:
HSUPA User Equipment Transmitter Test

RF Envelope
Power
ACLR
PCDE
EVM

Signals can be sent to
an ESG

 WMAN_DL_802_16e_TX:
Mobile WiMAX Downlink Transmitter Test

RF Envelope
Power
Constellation
Spectrum
EVM

Signals can be sent to
an ESG

 WMAN_DL_802_16e_RX_Sensitivity:
Mobile WiMAX Downlink Receiver Sensitivity Test

Reference Sensitivity Level  

 WMAN_UL_802_16e_TX:
Mobile WiMAX Uplink Transmitter Test

RF Envelope
Power
Constellation
Spectrum
EVM

Signals can be sent to
an ESG

 WMAN_UL_802_16e_RX_Sensitivity:
Mobile WiMAX Uplink Receiver Sensitivity Test

Reference Sensitivity Level  

 RF_PAE_EVM_ACLR:
RF Power Amplifier Test

Power Added Efficiency
Error Vector Magnitude
Adjacent Channel Leakage
Ratio

 

 TDSCDMA_DnLnk_TX:
TD-SCDMA Downlink Transmitter Test

RF Envelope
Constellation
Power
Spectrum
EVM

Signals can be sent to
an ESG

 TDSCDMA_UpLnk_TX:
TD-SCDMA Uplink Transmitter Test

RF Envelope
Constellation
Power
Spectrum
EVM

Signals can be sent to
an ESG

 TDSCDMA_DnLnk_MultiCarrier_TX:
TD-SCDMA Downlink Transmitter Test for Multi-carrier
Signals

Power
Spectrum

 

 TDSCDMA_DnLnk_RX_ACS: Adjacent Channel Selectivity  
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TD-SCDMA Downlink Receiver Test

 TDSCDMA_UpLnk_RX_Sensitivity:
TD-SCDMA Uplink Receiver Test

Reference Sensitivity Level  

 UWB_TX:
Ultra-Wideband Transmitter Test

RF Envelope
Power
Constellation
Spectrum
EVM

 

 UWB_RX_Sensitivity:
Ultra-Wideband Receiver Sensitivity Test

Reference Sensitivity Level  

 WLAN_802_11a_TX:
WLAN 802.11a/11g Transmitter Test

RF Envelope
Power
Constellation
Spectrum Mask
EVM

Signals can be sent to
an ESG

 WLAN_802_11a_RX_ACR:
WLAN 802.11a/11g Receiver Test

Adjacent Channel Rejection  

 WLAN_802_11a_RX_Sensitivity:
WLAN 802.11a/11g Receiver Test

Minimum Input Power
Sensitivity

 

 WLAN_802_11b_TX:
WLAN 802.11b/11g Transmitter Test

RF Envelope
Power
Constellation
Spectrum Mask
EVM

Signals can be sent to
an ESG

 WLAN_802_11b_RX_Sensitivity:
WLAN 802.11b/11g Receiver Test

Minimum Input Power
Sensitivity

 

 

 Wireless Sources

The following table lists the wireless sources in A/RF schematic. These wireless sources
provide standard compliant RF signals for WLAN, TD-SCDMA, and 3GPP FDD wireless
technologies. In addition to the RF signal, the TD-SCDMA and 3GPP FDD sources provide
baseband I and Q signals. These sources are highly configurable and can generate signals
with different rates, power levels, impairments, etc. For details about these sources, see
the online Components documentation Sources, Modulated-DSP-Based (ccsrc).

Source Name Description

 WLAN_802_11a WLAN 802.11a (OFDM) source

 WLAN_802_11b WLAN 802.11b (CCK/PBCC) source

 TDSCDMA_DnLink TD-SCDMA downlink source

 TDSCDMA_UpLink TD-SCDMA uplink source

 3GPPFDD_DnLink 3GPP FDD downlink source

 3GPPFDD_UpLink 3GPP FDD uplink source

 

 Wireless Expressions

The following table lists the commonly used wireless expressions for testing 3GPP FDD,
WLAN, and TD-SCDMA transmitters.
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See Measurement Expressions (expmeas) for details about using these expressions.
 

 Wireless Expressions

Measurement Expression Name

Baseband signal in time-domain real()

EVM measurement for WLAN DSSS/CCK/PBCC evm_wlan_dsss_cck_pbcc()

EVM measurement for WLAN OFDM evm_wlan_ofdm()

Magnitude of carrier in time-domain mag()

Phase of carrier in time-domain phase()

Power - CCDF† power_ccdf()

Power - Peak peak_pwr()

Power - Peak to Average peak_to_avg_pwr()

Power - Power vs. Time pwr_vs_t()

Power - Total total_pwr()

Spectrum analyzer †† spectrum_analyzer()

Spectrum of carrier in dB dB( fs() )

Spectrum of carrier in dBm dBm( fs() )

Voltage < named node > [1]

† The power_ccdf_ref() expression, which generates a reference curve for the Power-CCDF measurement, can
be used in transmitter testing. This expression is not available in the Expression Builder.
†† The spectrum_analyzer() and fs() expressions can be used for spectrum measurement. Although
spectrum_analyzer() uses fs() internally, it provides an easy way to set the measurement resolution
bandwidth as well as video averaging.

 

 RF Verification Examples

 RF Verification examples demonstrate how to use wireless test benches, sources, and
expressions. The examples can be accessed from the ADS Main window > File > Open >
Example :

HSUPA > HSUPA_RF_Verification_wrk
TDSCDMA > TDSCDMA_RF_Verification_wrk
UWB > UWB_RF_Verification_wrk
WCDMA3G > WCDMA3G_RF_Verification_wrk
WLAN > WLAN_RF_Verification_wrk
WMAN_M > WMAN_16e_OFDMA_RF_Verification_wrk

 

 Required Licenses
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 Licenses required to use wireless test bench models, wireless sources, and wireless
expressions are listed in the following table.

Feature Required Licenses

Wireless Test Bench Models, Sources, and Expressions (general) sim_envelope
sim_systime

3GPP FDD W-CDMA Wireless Design Library
for 3GPP FDD Wireless Test Bench Models, Sources, and Expressions

mdl_wcdma3g

EDGE Wireless Design Library
for EDGE Wireless Test Bench Models

mdl_edge

HSUPA Wireless Design Library
for HSUPA Wireless Test Bench Models

mdl_hsupa

Mobile WiMAX Wireless Design Library
for Mobile WiMAX Wireless Test Bench Models

mdl_wimax_mobile

TD-SCDMA Wireless Design Library
for TD-SCDMA Wireless Test Bench Models, Sources, and Expressions

mdl_tdscdma

Ultra-Wideband Wireless Design Library
for Ultra-Wideband Wireless Test Bench Models

mdl_ultrawideband

WLAN Wireless Design Library
for WLAN Wireless Test Bench Models, Sources, and Expressions

mdl_wlan
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